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1. Flash Card Master License
Flash Card Master program is free software; you can redistribute it and/or modify it under the terms of the GNU General Public Li-
cense as published by the Free Software Foundation; either version 3 of the License, or (at your option) any later version.

Flash Card Master program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public Li-
cense for more details.

You should have received a copy of the GNU General Public License along with this program; if not, write to the Free Software
Foundation,Inc.,59 Temple Place - Suite 330,Boston,MA 02111-1307, USA.

Full text available in Appendix D, GNU General Public License version 3 [] .

2. Credits

2.1. Translation

The following people helped translate Flash Card Master into various languages:

• Malayalam - Nithin Philips <spikiermonkey@user.sourceforge.net>

• Turkish - Çigdem Çavus <cavus_14@yahoo.com>

• Spanish - Gabriel Reyes <gareyes20@hotmail.com>

2.2. Components

The following people wrote components that made Flash Card Master possible:

• Magic Control Library 1.7.4.0: Phil Wright <http://www.dotnetmagic.com/>
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1 https://lists.sourceforge.net/lists/listinfo/flashcardmaster-info
2 http://sourceforge.net/mailarchive/forum.php?forum_name=flashcardmaster-info

• Tango Icon Project <http://tango.freedesktop.org/>

• Drag Drop ListView: Matt Hawley <http://www.codeproject.com/cs/miscctrl/DragAndDropListView.asp >

• CSV Reader 3.1.2: Sébastien Lorion <http://www.codeproject.com/cs/database/CsvReader.asp>.

• Vista Controls: Marco Minerva <http://www.codeplex.com/windowsformsaero>.

3. Getting More Help
If you have any questions about this document or Flash Card Master, you may contact me at
<spikiermonkey@users.sourceforge.net>.

A mailing list is also available at <flashcardmaster-info@lists.sourceforge.net> . You can subscribe1 or browse
archives2.
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1
Introduction

1.1. What Is Flash Card Master
Flash Card Master was written primarily to print flash cards, but over time has evolved into a full fledged application. Unlike other
flash card applications, Flash Card Master is design centric. Less telling, more showing. Here's a flash card made in Flash Card
Master:

Flash cards in Flash Card Master have a front and back side, here's the back of the same card:

1



Using Flash Card Master you will be able to have flash cards on screen and in print with same appearance. The features of Flash
Card Master are explained in detail in this document. We hope you will enjoy using Flash Card Master.

1.2. Walkthrough
Flash Card Master is ready to go as soon as you start it, however if you would like to customize the appearance of your flash cards,
this section will guide you through the steps to do so.

1. When you start Flash Card Master, the main window will look like this:

Introduction
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2. The default flash card deck, has two fields, Key and Answer. Let's rename the fields into something more sensible.

a. Click on button in the toolbar or Tools → Design. This will open the Card Designer.

Introduction
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b. Click on the Key field in the list at the top right.

c. In the text box below, delete the text Key and type in Word .

d. We will rename the Answer field as well. Let call it Definition.

3. Let's add an additional field.

a. Click on the button to add a new field.

b. Let's call the new field Chapter.

c. For the Sides, we will check both Front and Back. We will Position the field at the Top Right of the card and leave the Type
as Other.

4. Let's also reorder the fields

You can rearrange fields by grabbing them using the mouse. As you move around, a line will indicate where the item will be
placed. When you have reached the desired place, drop the item the put it there. Let's move the Chapter field you just created to
the top of the list.

Your list should now look like this:

Introduction

4



5. Click Close to close the dialog. You may be asked to save the file.

Yay, we're done. You have now created a flash card deck with three fields Chapter, Word , and Definition. The Chapter field will
appear on the front and back sides of the card at the top right corner. The Word field will be visible on the front center and the
Definition will be on the back center. You can add actual cards using the Edit Cards dialog ( button or Tools → Edit menu.)

I've added a card. Here's the front:

and the back:

Introduction
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1 http://msdn.microsoft.com/library/default.asp?url=/library/en-us/cpguide/html/cpconcomregularexpressions.asp

2
Main Window

This is the main window of Flash Card Master. You can manage your cards and access other features from here.

The check box next to the items will allow you to select an item. Unchecked items will not be shown when reviewing.

You can also search the fields of a deck in this window. Simply enter your query in the textbox at the right side of the toolbar. You
can click on the arrow next to the textbox to customize the search. You can limit the search to certain fields or use regular expres-
sions1 in your search. An introductory article on regular expressions is available at <ht-
tp://www.radsoftware.com.au/articles/regexlearnsyntax.aspx>
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Figure 2.1. Flash Card Master Main Window

2.1. The File menu

Main Window
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New
Creates a new flash card deck

Open...
Opens an existing flash card deck.

Open As Design...
Opens an existing flash card deck, however none of the actual cards will be loaded.

Recent Files
Shows a list of files that were opened recently.

Save
Saves the current flash card deck. You will be prompted to enter a filename if necessary.

Save As...
Saves the current flash card deck as a new file and switches the current file to that.

Import
Opens an existing flash card deck and append the cards to the existing deck. Note: The number of fields must be the same in
both files.

Page Setup...
Shows a dialog where you can configure print settings.

Print Preview

Main Window

9



Shows a preview of the cards as they will be printed.

Print...
Prints the current deck.

Exit
Quits the program.

2.2. The Edit menu

Cut
Cuts any selected items.

Copy
Copies any selected items.

Paste
Pastes any items in the clipboard.

Delete
Deletes any selected items.

Select All
Selects all items in the deck.

ChecAll/Uncheck All
Toggles the check state of all items. Unchecked items will not be shown in Review.

Preferences
Shows the Preferences dialog.

Main Window
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2.3. The Tools menu

Edit
Shows the card Editor dialog. You can add or edit individual cards here.

Design
Shows the card Designer dialog. You can alter the appearance of cards here.

Batch Add
Shows the Batch add dialog. You can quickly add multiple items here.

Review
Shows the card Review dialog.

Take Test
Starts the multiple choice test.

Locale
Allows you to change the user interface language.

Main Window
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3
Designing Cards

3.1. Card Designer
Card Designer allows you to change the appearance of flash cards. You can access it using Tools → Design

The ability to alter the appearance of cards is one of the key features of Flash Card Master. Each item on a card is called a field and
you can control the relative placement and the side on which the field will appear.

will add a new field to the deck and will delete an existing field.

The show radio buttons control the side that is shown. Choosing Front will show the front of the card, and Back will show the
back.

You can click on a field shown in the list to edit its properties. You can set the Name, which is a unique word to identify the field.
You can also choose the side on which the field will appear. If you check Front, the field will be shown on the front side of the
card. usually question goes here. Likewise, Back will place the field on the back side of the card. Answers are usually placed on
this side. You can also check both check boxes and the field will be shown on both sides. Checking neither will hide the field.

The Position property controls the placement of the field on the card. There are 9 possible values.

The Type property can be set to describe the contents of the field. Possible values are Key, Answer and Other. Key is the same
as a question. The property is used by the quiz component to generate quizzes. Other components may use this value as well. It is
recommended that you set this value. A card should only have one Key and one Answer.
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Figure 3.1. Design Cards Dialog

3.1.1. Keyboard Shortcuts

The following keyboard shortcuts are available in the Design Cards dialog.

CTRL + Q
Move the selected field up in the list.

Ctrl + A
Move the selected field down in the list.

Insert
Add a new field to the deck.

Delete
Deletes the selected field from the deck.

Designing Cards
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4
Editing Cards

4.1. Card Editor
The Card Editor allows easy editing of cards in a deck. You can access it using Tools → Edit

will add a new card to the deck and will delete an existing card.

To edit a card, click on the card in the Cards list, then the field you want to edit. You can enter text in the edit area at the top right.
If one of the card's field has been marked as Key, then the text shown in the Cards list will the text of that particular field, other-
wise all the fields will be shown, separated by a comma (see Card Designer to learn how to set the Type property of a field).

You can also edit more than one card at once. To do that select all the card you want to edit (Hold down the Ctrl key and click on
each the list item to select multiple items.) The edit area will say [Edit Multiple Items]. To change the value of the fields,
delete this text and enter your data. Please note that you cannot 'Undo' your changes, so be careful not to overwrite valuable in-
formation.

A preview of how the text you are entering will appear is shown on the bottom panel.

Note

You can change the proportional size of all the UI components in this dialog. For example, to make the edit area lar-
ger, place your mouse between the Fields list and the edit area. The cursor will change to the resize cursor. Hold
down the left mouse button and move the cursor to the left.
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Figure 4.1. Edit Cards Dialog

4.1.1. Keyboard Shortcuts

The following keyboard shortcuts are available in the Card Editor dialog.

CTRL + Up or Down Arrow Keys
Move the selection in the Cards list up and down

Alt + Up or Down Arrow Keys
Move the selection in the Fields list up and down

Insert
Add a new card to the deck

Editing Cards
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1 http://trac.edgewall.org/wiki/WikiFormatting

4.2. Batch Entry
The Batch Entry dialog allows you to add multiple cards by entering data in a single textbox. The format of the input is the same as
that of a CSV file. The only difference is that a header is not needed when entering data in a batch.

Instruction on how to enter data for a particular deck will be shown on the top. Each field is separated by a comma (,) character.
whitespace at the beginning and the end of a field will be ignored. Data for separate cards must be placed on separate lines. If your
input contains a comma character, place double quotes (") around the entire text for that field (see Section B.3, “Comma Separated
Value (.csv)” [26]for more.)

Figure 4.2. Batch Entry Window

4.3. Formatting Text
Text used in all the fields in Flash Card Master can easily formatted to achieve desired appearance. Flash Card Master uses Wiki-
Text, a simple syntax used mainly in wiki software to format content. The wiki text grammar used in Flash Card Master was adap-
ted from the Trac1 wiki.

WikiText is shown with formatting when Flash Card Master is displaying the cards. Flash Card Master can also convert the Wiki-
Text markup into XHTML format when you save a deck as XHTML (You must enable this in preferences).

Editing Cards
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All of the supported formattings are shown below. Please note that formattings cannot be nested (for example, there is no support
to format some text as Bold and Underlined).

Regular
'''Bold''' or *Bold*
''Italic''
'''''Bold Italic'''''
__Underline__
`Monospace`
~~Strikethru~~
Super^Script^
Sub,,Script,,

The above input will produce:

Example 4.1. All supported wiki formattings in Flash Card Master

Editing Cards
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5
Using Cards

5.1. The Reviewer
This is perhaps the most critical and most used feature of Flash Card Master. You can access it using Tools # Review → Normal or
Tools # Review → Shuffled. Normal will show the cards in order whereas the shuffled will show them in a random order.

Figure 5.1. Review Cards Dialog
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You can use the Left and Right arrow buttons to move between card. The flip button will flip a card.

The smiley faces allows you to keep track of the cards you have learned. Clicking the Smiling face ( ) will mark the card as

learned and that card will not be shown when you run the reviewer the next time. The plain face ( ) represents a card that you

have learned by may require more review. The sad face ( , default) will mark the card as not learned.

Checking the Animate checkbox will animate transitions. Uncheck this if you find it annoying.

If you want to review cards without having to manually click through each one, you can turn on the timer. You can control the
timer delays in the Preferences dialog.

5.1.1. Keyboard Shortcuts

The following keyboard shortcuts are available in the Review Cards dialog.

Left or Right
Move to the next or previous card.

Up or Down
Flip the card.

Shift
Flips the card, if Front is visible. Advances to the next card, if Back is visible.

5.2. Taking Tests
Flash Card Master currently offer one type of test. A Multiple choice test. You start it using Tools # Take Test.

Using Cards
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Figure 5.2. Multiple Choice Test Dialog

You will asked a question and allowed to pick the answer from four choices. At the end of the test a summary will be shown. You
also have the option to save the results as an HTML file.

Note

Since there are four choices for each question, your deck must have at least 4 cards in it.

Note

Flash Card Master can only generate a test if you mark the question and answer fields as such in the Card Designer.

Using Cards
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5.2.1. Keyboard Shortcuts

The following keyboard shortcuts are available in the Multiple Choice Test dialog.

Up, Down, Left or Right
Move between answer choices.

Enter
Proceed to the next question.

Backspace
Return to the previous question.

5.3. Printing Cards
If you want to review your flash cards away from the computer, it is a good idea to print them.

Flashcards are usually printed onto index cards, like the 3 in by 5 in or ISO-size A7. You can print on both sides of the card using
your printer's duplex feature or flash card master's built-in duplex feature.

When duplexing, depending on your printer, you may have to flip the paper around midway through. Please note that some printers
will not be able to print to index cards at all.

Tip

Some printers set their duplex property to capabele, even though they cannot. You can enable Flash card master's du-
plex feature to manually print on both sides of the paper. Do do so check the "Manually duplex when priting" option
in the Advanced tab of Preferences.

5.3.1. Other methods of printing

If you want to print out a list of the cards, save the deck as an XHTML file and use your browser's print function. We recommend
Firefox because it produces better output than Internet Explorer.

You can also save the deck as a .tex file and convert that to PDF. On Windows you can use MikTeX1 and TeXnicCenter2.

Finally, if you can write XSL style sheets, you can transform the data to a variety of formats that can suit your needs.

Using Cards
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6
Tips and Tricks

6.1. Changing the color of fields

Note

While you can still follow the steps here, in Flash card Master 1.0 you can change the colors in the Card Designer dia-
log. The only limitation of the UI is that you cannot set the transparency (alpha) of the colors.

If you save a deck as a CML file, you can manually edit the file using a Text Editor and modify the Field element.

<Field
index="0"
name="Chapter"
type="Other"
side="Both"
position="Top, Right"
forecolor="argb(255,0,0,0)"
backcolor="argb(0,255,255,255)"

/>

forecolor specifies the color of the text and backcolor specifies the color of the text background. There are two ways to spe-
cify the color. One is rgb([0-255], [0-255], [0-255]) and the other is ar-
gb([0-255],[0-255],[0-255],[0-255]), which specifies an alpha channel value as well.

For example forecolor="argb(255,0,0,0)" and backcolor="argb(200,241,113,65)" will produce the follow-
ing output.

Tip

Once you have made your changes in CML, you can save to CARD or XHTML formats and the color information
will be preserved.
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6.2. Merging files with different number of fields
If you have two different files with different number of fields (for example fileA with {Question, Answer} and fileB with
{Chapter, Question, Answer}) you can merge them easily.

First, open the file with least number of fields (fileA), then using the Card Designer add fields (Chapter) to match the second file
(fileB). Make sure the order of the fields are the same in both files. You can now import the second file (fileB) using File → Im-
port.

Tips and Tricks
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2 http://www.everylittlething.net/GlobalResource/

Appendix A. Localizing Flash Card
Master

Steps to Localize Flash Card Master

1. Download Language.resx1 (Contains all the strings that can be localized.)

2. Download and install Global Resource Editor2 (Allows you to edit the .resx file.)

3. Open 'Global Resource Editor' and click on Language → New Language. Menu and from the list choose your language.

4. You can now add localized strings to the new column.

5. Save the file by clicking File → Save Resource Set As.... When prompted to enter a file name use Language.resx. Separate
.resx files for all your languages will be created. Spanish localization, for example, will be in Language.es.resx

6. If you have Visual Studio 2005 Check out source from sourceforge SVN and you can compile the .resx file into a DLL and test
it out.

If you don't have Visual Studio see http://www.codeproject.com/dotnet/Localization.asp. You may need to install .NET frame-
work SDK before following the instructions there.

7. When you are done, E-mail the completed .resx to <spikiermonkey@users.sourceforge.net> Be sure to include
the name and email address (if at all) you want to be shown in the credits.

Tip

Run Flash Card Master while you are translating so that you can see the context in which the text appears.

More Info

• .NET Framework documentation on CultureInfo http://msdn2.microsoft.com/en-us/library/system.globalization.cultureinfo.aspx

If you have any questions or need help, contact the developer at <spikiermonkey@users.sourceforge.net>
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Appendix B. Supported File Types
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B.1. Card Markup Language (.cml)
Card Markup Language is an XML based file format. This format is fully supported by Flash Card Master.

If you would like to manually edit the CML files, a document type definition has been written in RelaxNG, available at ht-
tp://flashcardmaster.sourceforge.net/cardml/1.0/relaxng. If you prefer an XSD schema is also available at ht-
tp://flashcardmaster.sourceforge.net/cardml/1.0/schema.

<?xml version="1.0" encoding="utf-8" standalone="no"?>
<CardDeck xsi:noNamespaceSchemaLocation="http://flashcardmaster.sourceforge.net/cardml/1.0/schema"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<Fields>

<Field index="0" name="Key" type="Key" side="Front" position="Center" />
<Field index="1" name="Answer" type="Answer" side="Back" position="Center" />

</Fields>
<Cards>

<Card learned="NotLearned">
<CardField name="Key">Key</CardField>
<CardField name="Answer">Answer</CardField>

</Card>
</Cards>

</CardDeck>

Example B.1. A sample CML file

B.2. Card File (.card)
Card is binary file format. It is fully supported by Flash Card Master.

Card files are written using the .NET object serializer and will become incompatible if the object model is changed in the future. If
you need to use files across incompatible versions, you will need to save the file as a .cml file.
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1 http://en.wikipedia.org/wiki/XSL_Transformations
2 http://miktex.org/
3 http://www.toolscenter.org/

B.3. Comma Separated Value (.csv)
Flash Card Master has limited support for csv files. They can be read from and written to, however any customizations of field ap-
pearance (like position, colors etc.) will be lost. Only names of the fields are saved.

CSV files can be useful if you prefer to edit or already have a flash card collection in Excel or another spreadsheet program. A
sample CSV file is shown below.

Chapter,Word,Meaning,Derivatives [1]
I,më,"me,myself", [2]
I,quid,what,(quid pro quo) [2]

This is the header. The name of each field is required and is separated by a comma (or another character set in the prefer-
ences).
These are the data. Commas inside double quotes are not counted as separators and are considered part of the data.

B.4. XHTML
Flash Card Master can save data as an XHTML file, but cannot open it due to the inherent limitations of the format. Saving as
XHTML will only make a copy of the opened file in XHTML.

The XHTML format is intended for presenting your cards. Using XSLT1, you can customize the appearance of the XHTML file
produced. To use a custom XSLT, save it as Style.xslt in the %APPDATA%\Nithin Philips\Flash Card Mas-
ter\<Version> directory. On a typical system this is usually: C:\Documents and Set-
tings\<User>\Application Data\Nithin Philips\Flash Card Master\<Version>.

Warning

If your custom XSLT is malformed, the program may behave unexpectedly or crash. Be sure to test the style sheet
(with an external tool or by making a dummy deck) before using it.

Please also note that when saving as CML files, Flash Card Master will write color values in argb() format, however CSS only sup-
ports rgb() format. You will need to manually convert argb() to rgb() or transform it somehow. This is not an issue when you save
as XHTML files, because Flash Card Master will make the necessary conversions. See Section 6.1, “Changing the color of fields”
[22] for more details.

The default XSL stylesheet is available at http://flashcardmaster.sourceforge.net/cardml/1.0/transform

B.5. LaTeX (.tex)
Flash Card Master can save to LaTeX format, but cannot open it. The .tex file itself is not very useful, but you can use MikTeX2

and TeXnicCenter3 to transform it to PS or PDF.

Supported File Types
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\documentclass[12pt,letterpaper,oneside]{article}
\usepackage{ulem}

\title{Flash Card List}
\author{Douglas Adams}
\date{\today}

\begin{document}
\maketitle{}

\begin{description}
\item[Answer to Life, the Universe, and Everything] 42

\end{description}

\end{document}

Example B.2. Sample TeX output

B.6. Flashcard Pro (.xfs)
Flashcard Pro is an alternative flashcard program. It is available at <ht-
tp://www.donationcoder.com/Forums/bb/index.php?topic=4810.msg33933>. Flashcard Pro files can only handle a Key and a
Value field, therefore any other information in your deck will be lost when saved to this format. Also, you must have fields desig-
nated Key and Answer (using Card Designer) before being able to save as this format.

Supported File Types
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1 http://www.microsoft.com/downloads/details.aspx?FamilyId=E6E1C3DF-A74F-4207-8586-711EBE331CDC&displaylang=en

Appendix C. Building Source

With Visual Studio 2008. Simply open Flash Card Master.sln in Visual Studio and build.

With Visual Studio Express 2008. Simply open Flash Card Master.sln in Visual Studio and build. You can download it
from <http://www.microsoft.com/express/vcsharp/>

Manual Build.

1. You may need .NET Framework 3.5 SDK. Get it1 from Microsoft website.

2. Execute Build-Release.bat file in the source root directory. MSBuild tool is used to perform the build.
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Appendix D. GNU General Public
License version 3

Version 3, 29 June 2007

Copyright © 2007 Free Software Foundation, Inc. http://fsf.org/

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble
The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works.
By contrast, the GNU General Public License is intended to guarantee your freedom to share and change all versions of a pro-
gram—to make sure it remains free software for all its users. We, the Free Software Foundation, use the GNU General Public Li-
cense for most of our software; it applies also to any other work released this way by its authors. You can apply it to your pro-
grams, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure
that you have the freedom to distribute copies of free software (and charge for them if you wish), that you receive source code or
can get it if you want it, that you can change the software or use pieces of it in new free programs, and that you know you can do
these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore,
you have certain responsibilities if you distribute copies of the software, or if you modify it: responsibilities to respect the freedom
of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same
freedoms that you received. You must make sure that they, too, receive or can get the source code. And you must show them these
terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this
License giving you legal permission to copy, distribute and/or modify it.

For the developers’ and authors’ protection, the GPL clearly explains that there is no warranty for this free software. For both
users’ and authors’ sake, the GPL requires that modified versions be marked as changed, so that their problems will not be attrib-
uted erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the manu-
facturer can do so. This is fundamentally incompatible with the aim of protecting users’ freedom to change the software. The sys-
tematic pattern of such abuse occurs in the area of products for individuals to use, which is precisely where it is most unacceptable.
Therefore, we have designed this version of the GPL to prohibit the practice for those products. If such problems arise substantially
in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the
freedom of users.
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Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use
of software on general-purpose computers, but in those that do, we wish to avoid the special danger that patents applied to a free
program could make it effectively proprietary. To prevent this, the GPL assures that patents cannot be used to render the program
non-free.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. Definitions.
“This License” refers to version 3 of the GNU General Public License.

“Copyright” also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.

“The Program” refers to any copyrightable work licensed under this License. Each licensee is addressed as “you”. “Licensees” and
“recipients” may be individuals or organizations.

To “modify” a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the
making of an exact copy. The resulting work is called a “modified version” of the earlier work or a work “based on” the earlier
work.

A “covered work” means either the unmodified Program or a work based on the Program.

To “propagate” a work means to do anything with it that, without permission, would make you directly or secondarily liable for in-
fringement under applicable copyright law, except executing it on a computer or modifying a private copy. Propagation includes
copying, distribution (with or without modification), making available to the public, and in some countries other activities as well.

To “convey” a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with a
user through a computer network, with no transfer of a copy, is not conveying.

An interactive user interface displays “Appropriate Legal Notices” to the extent that it includes a convenient and prominently vis-
ible feature that (1) displays an appropriate copyright notice, and (2) tells the user that there is no warranty for the work (except to
the extent that warranties are provided), that licensees may convey the work under this License, and how to view a copy of this Li-
cense. If the interface presents a list of user commands or options, such as a menu, a prominent item in the list meets this criterion.

1. Source Code.
The “source code” for a work means the preferred form of the work for making modifications to it. “Object code” means any non-
source form of a work.

A “Standard Interface” means an interface that either is an official standard defined by a recognized standards body, or, in the case
of interfaces specified for a particular programming language, one that is widely used among developers working in that language.

The “System Libraries” of an executable work include anything, other than the work as a whole, that (a) is included in the normal
form of packaging a Major Component, but which is not part of that Major Component, and (b) serves only to enable use of the
work with that Major Component, or to implement a Standard Interface for which an implementation is available to the public in
source code form. A “Major Component”, in this context, means a major essential component (kernel, window system, and so on)
of the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an object
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code interpreter used to run it.

The “Corresponding Source” for a work in object code form means all the source code needed to generate, install, and (for an ex-
ecutable work) run the object code and to modify the work, including scripts to control those activities. However, it does not in-
clude the work’s System Libraries, or general-purpose tools or generally available free programs which are used unmodified in per-
forming those activities but which are not part of the work. For example, Corresponding Source includes interface definition files
associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms that the
work is specifically designed to require, such as by intimate data communication or control flow between those subprograms and
other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding
Source.

The Corresponding Source for a work in source code form is that same work.

2. Basic Permissions.
All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the stated
conditions are met. This License explicitly affirms your unlimited permission to run the unmodified Program. The output from run-
ning a covered work is covered by this License only if the output, given its content, constitutes a covered work. This License ac-
knowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise re-
mains in force. You may convey covered works to others for the sole purpose of having them make modifications exclusively for
you, or provide you with facilities for running those works, provided that you comply with the terms of this License in conveying
all material for which you do not control copyright. Those thus making or running the covered works for you must do so exclus-
ively on your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted
material outside their relationship with you.

Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; sec-
tion 10 makes it unnecessary.

3. Protecting Users’ Legal Rights From Anti-
Circumvention Law.
No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under
article 11 of the WIPO copyright treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of
such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such
circumvention is effected by exercising rights under this License with respect to the covered work, and you disclaim any intention
to limit operation or modification of the work as a means of enforcing, against the work’s users, your or third parties’ legal rights to
forbid circumvention of technological measures.

4. Conveying Verbatim Copies.
You may convey verbatim copies of the Program’s source code as you receive it, in any medium, provided that you conspicuously
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and appropriately publish on each copy an appropriate copyright notice; keep intact all notices stating that this License and any
non-permissive terms added in accord with section 7 apply to the code; keep intact all notices of the absence of any warranty; and
give all recipients a copy of this License along with the Program.

You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.

5. Conveying Modified Source Versions.
You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code un-
der the terms of section 4, provided that you also meet all of these conditions:

a. The work must carry prominent notices stating that you modified it, and giving a relevant date.

b. The work must carry prominent notices stating that it is released under this License and any conditions added under section 7.
This requirement modifies the requirement in section 4 to “keep intact all notices”.

c. You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This License
will therefore apply, along with any applicable section 7 additional terms, to the whole of the work, and all its parts, regardless
of how they are packaged. This License gives no permission to license the work in any other way, but it does not invalidate such
permission if you have separately received it.

d. If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has interactive
interfaces that do not display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the
covered work, and which are not combined with it such as to form a larger program, in or on a volume of a storage or distribution
medium, is called an “aggregate” if the compilation and its resulting copyright are not used to limit the access or legal rights of the
compilation’s users beyond what the individual works permit. Inclusion of a covered work in an aggregate does not cause this Li-
cense to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.
You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the ma-
chine-readable Corresponding Source under the terms of this License, in one of these ways:

a. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the
Corresponding Source fixed on a durable physical medium customarily used for software interchange.

b. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by a
written offer, valid for at least three years and valid for as long as you offer spare parts or customer support for that product
model, to give anyone who possesses the object code either (1) a copy of the Corresponding Source for all the software in the
product that is covered by this License, on a durable physical medium customarily used for software interchange, for a price no
more than your reasonable cost of physically performing this conveying of source, or (2) access to copy the Corresponding
Source from a network server at no charge.

c. Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This alternat-
ive is allowed only occasionally and noncommercially, and only if you received the object code with such an offer, in accord
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with subsection 6b.

d. Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access to the
Corresponding Source in the same way through the same place at no further charge. You need not require recipients to copy the
Corresponding Source along with the object code. If the place to copy the object code is a network server, the Corresponding
Source may be on a different server (operated by you or a third party) that supports equivalent copying facilities, provided you
maintain clear directions next to the object code saying where to find the Corresponding Source. Regardless of what server hosts
the Corresponding Source, you remain obligated to ensure that it is available for as long as needed to satisfy these requirements.

e. Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and Corres-
ponding Source of the work are being offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need
not be included in conveying the object code work.

A “User Product” is either (1) a “consumer product”, which means any tangible personal property which is normally used for per-
sonal, family, or household purposes, or (2) anything designed or sold for incorporation into a dwelling. In determining whether a
product is a consumer product, doubtful cases shall be resolved in favor of coverage. For a particular product received by a particu-
lar user, “normally used” refers to a typical or common use of that class of product, regardless of the status of the particular user or
of the way in which the particular user actually uses, or expects or is expected to use, the product. A product is a consumer product
regardless of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent the only
significant mode of use of the product.

“Installation Information” for a User Product means any methods, procedures, authorization keys, or other information required to
install and execute modified versions of a covered work in that User Product from a modified version of its Corresponding Source.
The information must suffice to ensure that the continued functioning of the modified object code is in no case prevented or in-
terfered with solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying oc-
curs as part of a transaction in which the right of possession and use of the User Product is transferred to the recipient in perpetuity
or for a fixed term (regardless of how the transaction is characterized), the Corresponding Source conveyed under this section must
be accompanied by the Installation Information. But this requirement does not apply if neither you nor any third party retains the
ability to install modified object code on the User Product (for example, the work has been installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to provide support service, war-
ranty, or updates for a work that has been modified or installed by the recipient, or for the User Product in which it has been modi-
fied or installed. Access to a network may be denied when the modification itself materially and adversely affects the operation of
the network or violates the rules and protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is pub-
licly documented (and with an implementation available to the public in source code form), and must require no special password
or key for unpacking, reading or copying.

7. Additional Terms.
“Additional permissions” are terms that supplement the terms of this License by making exceptions from one or more of its condi-
tions. Additional permissions that are applicable to the entire Program shall be treated as though they were included in this License,
to the extent that they are valid under applicable law. If additional permissions apply only to part of the Program, that part may be
used separately under those permissions, but the entire Program remains governed by this License without regard to the additional
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permissions.

When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from
any part of it. (Additional permissions may be written to require their own removal in certain cases when you modify the work.)
You may place additional permissions on material, added by you to a covered work, for which you have or can give appropriate
copyright permission.

Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the copy-
right holders of that material) supplement the terms of this License with terms:

a. Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or

b. Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate Legal
Notices displayed by works containing it; or

c. Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in
reasonable ways as different from the original version; or

d. Limiting the use for publicity purposes of names of licensors or authors of the material; or

e. Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or

f. Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions
of it) with contractual assumptions of liability to the recipient, for any liability that these contractual assumptions directly im-
pose on those licensors and authors.

All other non-permissive additional terms are considered “further restrictions” within the meaning of section 10. If the Program as
you received it, or any part of it, contains a notice stating that it is governed by this License along with a term that is a further re-
striction, you may remove that term. If a license document contains a further restriction but permits relicensing or conveying under
this License, you may add to a covered work material governed by the terms of that license document, provided that the further re-
striction does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the addi-
tional terms that apply to those files, or a notice indicating where to find the applicable terms.

Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions;
the above requirements apply either way.

8. Termination.
You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to
propagate or modify it is void, and will automatically terminate your rights under this License (including any patent licenses gran-
ted under the third paragraph of section 11).

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provision-
ally, unless and until the copyright holder explicitly and finally terminates your license, and (b) permanently, if the copyright hold-
er fails to notify you of the violation by some reasonable means prior to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the viol-
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ation by some reasonable means, this is the first time you have received notice of violation of this License (for any work) from that
copyright holder, and you cure the violation prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you
under this License. If your rights have been terminated and not permanently reinstated, you do not qualify to receive new licenses
for the same material under section 10.

9. Acceptance Not Required for Having Copies.
You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered
work occurring solely as a consequence of using peer-to-peer transmission to receive a copy likewise does not require acceptance.
However, nothing other than this License grants you permission to propagate or modify any covered work. These actions infringe
copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, you indicate your acceptance
of this License to do so.

10. Automatic Licensing of Downstream Recipi-
ents.
Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and
propagate that work, subject to this License. You are not responsible for enforcing compliance by third parties with this License.

An “entity transaction” is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an
organization, or merging organizations. If propagation of a covered work results from an entity transaction, each party to that trans-
action who receives a copy of the work also receives whatever licenses to the work the party’s predecessor in interest had or could
give under the previous paragraph, plus a right to possession of the Corresponding Source of the work from the predecessor in in-
terest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, you
may not impose a license fee, royalty, or other charge for exercise of rights granted under this License, and you may not initiate lit-
igation (including a cross-claim or counterclaim in a lawsuit) alleging that any patent claim is infringed by making, using, selling,
offering for sale, or importing the Program or any portion of it.

11. Patents.
A “contributor” is a copyright holder who authorizes use under this License of the Program or a work on which the Program is
based. The work thus licensed is called the contributor’s “contributor version”.

A contributor’s “essential patent claims” are all patent claims owned or controlled by the contributor, whether already acquired or
hereafter acquired, that would be infringed by some manner, permitted by this License, of making, using, or selling its contributor
version, but do not include claims that would be infringed only as a consequence of further modification of the contributor version.
For purposes of this definition, “control” includes the right to grant patent sublicenses in a manner consistent with the requirements
of this License.

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor’s essential patent claims,
to make, use, sell, offer for sale, import and otherwise run, modify and propagate the contents of its contributor version.

In the following three paragraphs, a “patent license” is any express agreement or commitment, however denominated, not to en-
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force a patent (such as an express permission to practice a patent or covenant not to sue for patent infringement). To “grant” such a
patent license to a party means to make such an agreement or commitment not to enforce a patent against the party.

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for
anyone to copy, free of charge and under the terms of this License, through a publicly available network server or other readily ac-
cessible means, then you must either (1) cause the Corresponding Source to be so available, or (2) arrange to deprive yourself of
the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the requirements of this Li-
cense, to extend the patent license to downstream recipients. “Knowingly relying” means you have actual knowledge that, but for
the patent license, your conveying the covered work in a country, or your recipient’s use of the covered work in a country, would
infringe one or more identifiable patents in that country that you have reason to believe are valid.

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a
covered work, and grant a patent license to some of the parties receiving the covered work authorizing them to use, propagate,
modify or convey a specific copy of the covered work, then the patent license you grant is automatically extended to all recipients
of the covered work and works based on it.

A patent license is “discriminatory” if it does not include within the scope of its coverage, prohibits the exercise of, or is condi-
tioned on the non-exercise of one or more of the rights that are specifically granted under this License. You may not convey a
covered work if you are a party to an arrangement with a third party that is in the business of distributing software, under which
you make payment to the third party based on the extent of your activity of conveying the work, and under which the third party
grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with
copies of the covered work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with spe-
cific products or compilations that contain the covered work, unless you entered into that arrangement, or that patent license was
granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may
otherwise be available to you under applicable patent law.

12. No Surrender of Others’ Freedom.
If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License,
they do not excuse you from the conditions of this License. If you cannot convey a covered work so as to satisfy simultaneously
your obligations under this License and any other pertinent obligations, then as a consequence you may not convey it at all. For ex-
ample, if you agree to terms that obligate you to collect a royalty for further conveying from those to whom you convey the Pro-
gram, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the Program.

13. Use with the GNU Affero General Public Li-
cense.
Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work li-
censed under version 3 of the GNU Affero General Public License into a single combined work, and to convey the resulting work.
The terms of this License will continue to apply to the part which is the covered work, but the special requirements of the GNU Af-
fero General Public License, section 13, concerning interaction through a network will apply to the combination as such.

14. Revised Versions of this License.
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The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time.
Such new versions will be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU Gener-
al Public License “or any later version” applies to it, you have the option of following the terms and conditions either of that
numbered version or of any later version published by the Free Software Foundation. If the Program does not specify a version
number of the GNU General Public License, you may choose any version ever published by the Free Software Foundation.

If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that
proxy’s public statement of acceptance of a version permanently authorizes you to choose that version for the Program.

Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any au-
thor or copyright holder as a result of your choosing to follow a later version.

15. Disclaimer of Warranty.
THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT
WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE
PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD
THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR COR-
RECTION.

16. Limitation of Liability.
IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT
HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE
LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAM-
AGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS
OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A
FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER
PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.
If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms,
reviewing courts shall apply local law that most closely approximates an absolute waiver of all civil liability in connection with the
Program, unless a warranty or assumption of liability accompanies a copy of the Program in return for a fee.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Pro-
grams
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If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve this is to
make it free software which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most effectively
state the exclusion of warranty; and each file should have at least the “copyright” line and a pointer to where the full notice is
found.

one line to give the program’s name and a brief idea of what it does.
Copyright (C) year

name of author

This program is free software: you can redistribute it and/or modify
it under the terms of the GNU General Public License as published by
the Free Software Foundation, either version 3 of the License, or
(at your option) any later version.

This program is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details.

You should have received a copy of the GNU General Public License
along with this program. If not, see http://www.gnu.org/licenses/.

Also add information on how to contact you by electronic and paper mail.

If the program does terminal interaction, make it output a short notice like this when it starts in an interactive mode:

program Copyright (C) year
name of author

This program comes with ABSOLUTELY NO WARRANTY; for details type ‘show w’.
This is free software, and you are welcome to redistribute it
under certain conditions; type ‘show c’ for details.

The hypothetical commands ‘show w’ and ‘show c’ should show the appropriate parts of the General Public License. Of course,
your program’s commands might be different; for a GUI interface, you would use an “about box”.

You should also get your employer (if you work as a programmer) or school, if any, to sign a “copyright disclaimer” for the pro-
gram, if necessary. For more information on this, and how to apply and follow the GNU GPL, see http://www.gnu.org/licenses/.

The GNU General Public License does not permit incorporating your program into proprietary programs. If your program is a sub-
routine library, you may consider it more useful to permit linking proprietary applications with the library. If this is what you want
to do, use the GNU Lesser General Public License instead of this License. But first, please read ht-
tp://www.gnu.org/philosophy/why-not-lgpl.html.
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